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Congratulations!

You�ve just purchased a powerful device that will give you powerful
automatic and remote control of virtually everything electric or elec-
trical in your house.

HouseLinc comes pre-programmed with the world�s largest infrared
control library right on-board.  So setting up control of a home the-
ater is simple.  Further, it has 5 programmable infrared output zones
which allow you to easily setup and control a wholehouse
audio/video system.

With the use of SmartLinc ProbeLincs, HouseLinc is made aware of
the On or Off status of a audio/video device and is capable of fully
automating a home theater system.  Add a HubLinc and HouseLinc
can be �hardwired� to TouchLincs for virtually instantaneous touch-
screen triggered output.

You can also control any of the 256 X-10 addresses on your homes
AC wiring.  With the assistance of 100�s of products available
through home automation and electrical distributors and retailers,
you�ll be able to control lighting, appliances, locks, window covering
controllers, HVAC systems, security, sprinklers, systems and just
about anything else you can imagine.
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Components

1) HouseLinc

2) Power Supply

3) PowerLine Interface (pictured below) and �phone� patch cord
(Not Pictured).

4) Serial �download� cable (Not Pictured).

5) SmartLinc Suite installations disks (3 disks - Not Pictured)

Notes:  You will need need a 386 or better computer running
Windows 3.1, Windows 95 or Windows 98  to program HouseLinc.
Once programmed, HouseLinc is a fully functional stand-alone con-
troller.

3

http://www.smarthome.com
http://www.smarthome.com


Smarthome.com, Inc.  (800) SMART-HOME  (949) 221-9200
http://smarthome.com

HouseLinc

Front View:

Rear View:
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HouseLinc� Basics

HouseLinc is a whole-house controller that controls X-10, infrared
and other devices.  With powerful, yet easy to use, software you can
program elegant lighting scenes or helpful home theater events to
occur at certain times of the day, in response to an X-10 signal,
input from a RS-232 touchscreen or in response to input from the
computer.

You can program hundreds of events into HouseLinc.  Further,  you
can create �conditionals� (if-then logic) into your events if you desire.

This manual is designed to be a �quick-start� guide and to familiarize
yourself with HouseLinc.  Full, on-line help is available in the soft-
ware.

Please note: Plato HouseLinc and HouseLinc are synonymous.

What You�ll Need

1 The HouseLinc and enclosed components.
2. A 386 or better computer running Windows 3.1, Windows 95

or Windows 98.
3. A 9 pin COM port on your computer (for download and direct

control only).  If your computer only has a 25 pin port, you
will need to acquire a 25 pin to 9 pin adapter.

3. Two standard 110V outlets at desired installation location.
4. X-10 compatible receivers if you wish to automate lighting,

appliances or other similar accessories.
5. Infrared controllable devices if you wish to automate home

theater or audio/video control.
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HouseLinc Hardware Installation

Make connections as per the following diagram:

1. Locate a free serial (COM) port: Consult the documentation
that came with your PC.  COM ports (either 9 or 25 pin con-
nectors) are often labeled somewhere on the back of your
PC.  The label may read COMx where x is 1, 2, 3, or 4.  Or,
the label may read something like Serial Port x where x is 1,
2, 3, or 4.  If the only free COM port on your computer is the
25 pin variety, you will need a 25 pin to 9 pin adapter widely
available at most computer & electronics stores.

2. Plug one end of the enclosed download cable into the free
COM port located in step one and the other end into the
Serial Port on the back of HouseLinc.

3. Plug the AC Adapter into a standard 110V wall outlet or pow-
erstrip and into the power jack on the back of HouseLinc.
(Note:  If you are connecting three or more BOBs to a
HouseLinc, you will need to use an 800 mA power sup-
ply (SmartLinc part #8025)).

4. The green �Status/X10� LED on the HouseLinc Interface
should start blinking once per second.  If not, see
Troubleshooting.

5. Plug in the powerline interface module which allows the
HouseLinc Interface to send and receive X10 signals.  The
powerline interface module plugs into any standard AC out-
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let.  Note that many power strips with good surge suppres-
sors can filter out X10 signals, so you should avoid plugging
the powerline interface module into one.

6. Connect the powerline interface module to the HouseLinc
Interface.  The powerline interface module connects to the
HouseLinc Interface using the standard telephone cable
included with your HouseLinc unit.  Clip one end of the cable
into the bottom of the powerline interface module, and clip
the other end into the port labeled "X10" on the HouseLinc
Interface.

7. Install a 9V battery into the battery compartment on the bot-
tom of HouseLinc (the unit will operate without the battery,
but power outages will cause the unit to lose its date and
time settings, you may need to pry open the battery compart-
ment using a small screwdriver).  The green status LED on
the front of HouseLinc should stop blinking.

SmartLinc Suite Software Installation
The SmartLinc Suite contains two setup software programs for
HouseLinc (PlatoTW.exe and MHM.exe) and one setup program for
TouchLinc (TOUCHLINC.exe).   Depending on what SmartLinc hard-
ware you have, you may not need all the software packages con-
tained in the Suite.

1. Boot your PC into Windows.
2. Insert the diskette labeled "SmartLinc Suite� into your floppy

diskette drive.
3. Depending on operating system:

A) For Windows 95, click on the Start button and
choose Run.  Type A:SETUP.EXE in the dialog and
click OK.
B) For Windows 3.x, Use the File menu from the
Program Manager and choose Run.  Type
A:SETUP.EXE in the Command Line: and click OK.

7

http://www.smarthome.com
http://www.smarthome.com


Smarthome.com, Inc.  (800) SMART-HOME  (949) 221-9200
http://smarthome.com

4. Click Next to continue beyond the Welcome Screen.
5. Review the Readme information screen and then press Next

to continue.
6. In the Choose Destination Location window, click on the next

button to accept the default subdirectory (c:\smartlnc) or
change to another subdirectory if desired (if you had a previ-
ous version of Plato HouseLinc software, the suite installa-
tion program will find it and import your current configuration
and you will also be instructed on how to import other pre-
defined configurations).

7. In the Setup Type window click on the next button to accept
the default installation of all three software packages.  Click
Custom if you wish to install only a subset of the packages.

8. In the Select Program Folder window click on the next button
to accept the default program folder �SmartLinc Suite� or
enter another name if desired.

9. In the Start Copying Files window click on the next button to
begin the actual installation of files to your computer.

10. Insert Disk 2 and click OK when prompted.
11. Insert Disk 3 and click OK when prompted
12. In the Setup Complete Window click in the Yes checkbox if

you wish to review installation notes.
13. Click Finish to complete the installation of the SmartLinc

Suite.

Running HouseLinc Software

PlatoTW.exe is the setup and control software for HouseLinc.  It is
recommended that you launch PlatoTW.exe from within Multi-
House-Manager.
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MHM.exe (Multi-House-Manager) allows you to save setups for mul-
tiple homes (or create backup of an individual home�s setup).  The
use of MHM is highly recommended for dealers (for multiple home
purposes) as well as for individual homeowners (for backup purpos-
es).

To Launch Multi-House-Manager
1. Press the Start Button
2. Click on Programs
3. Click on SmartLinc Suite (or other name you selected during

Suite installation)
4. Click on Multi-House-Manager
5. The white, rectangular box in the middle of the MHM window

will display all the �com� devices that MHM has found (e.g.
HouseLinc found on COM1, Modem found on COM2).
Clicking on this box will cause MHM to re-examine the com
ports and update this information.

6. If you had a previous version of Multi-House-Manager
installed:

MHM will load with your current setup called
�Original�
a)  Select Save As from the File menu to save the
setup with a more descriptive name.
b)  Select Import Config from the file menu to import
your other MHM files from your previous installation
subdirectory (probably c:\platotw) into your current
subdirectory (probably c:\smartlnc).

7. Select Open Config from the File menu and select PLC-
1184.MHM.  This will launch PlatoTW.exe (the HouseLinc
setup and control software) and instruct the software to
establish communications with the HouseLinc controller..

8. If HouseLinc is not properly connected or if your HouseLinc
is not on COM1, you will receive the following �No
Response� message:
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If you receive this message switch back to MHM and refer-
ring to the white box in the middle of the MHM window, con-
firm which COM port HouseLinc is connected to.
If MHM does not report HouseLinc on any COM ports:

You have a connection problem.  Check cables and
refer back to the �HouseLinc Hardware Installation�
section of this manual.  (You may need to �reset�
HouseLinc - to do so, remove the 9V battery and
unplug the 12V power supply for a few seconds.  This
completely resets HouseLinc).

If HouseLinc�s COM port is listed:
Switch back to Plato HouseLinc and select the cor-
rect COM port from the Interface menu.

9. You may also receive a message that the battery needs
replacement.  This is simply a warning message.  HouseLinc
will operate properly without the battery.  However, if a power
outage should occur, all your device and event programming
will remain in tact but HouseLinc�s clock will lose its correct
settings.

10. You might also receive a message that the powerline inter-
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face was not connected (the software may refer to the pow-
erline interface as a TW-523).  If you receive this message,
confirm that the powerline interface connections are proper-
ly established and that the powerline interface is plugged
into a live outlet.

11. Setting the HouseLinc clock: In order for timer events to
occur accurately you will need to set HouseLinc�s internal
clock.  Select Set Clock from the Interface menu.

Click on the button just below �Sync with system clock� with
the time and date (which has been copied from your com-
puter�s clock) to synchronize HouseLinc with your PC�s
clock (alternately, you may enter the time in the box above
the �Sync� button).

12. Specifying your Latitude and Longitude: Plato-HouseLinc
needs your Latitude and Longitude to calculate sunrise and
sunset times throughout the year.  Select Set Lat/Long...
from the Interface menu.
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a) Use the listbox to select the city nearest you.
b) Click on the ReCalc button to recalculate the sunrise/sun-
set table.
c) Select Download sunrise/sunset table from the Interface
menu to download the accurate data to HouseLinc.

13. Your first time installation is complete!

Setting up X-10 Devices

1. Select the Units Window.  Upon starting the software for the
first time several default windows should be open.  The win-
dow titled �Units� is the window that contains the X-10 com-
patible devices.  When launching the HouseLinc software for
the first time, the X-10 devices which are defined at the fac-
tory will be listed:

A lamp on the X-10 address C-1 is listed.  Also, four �flags�
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that correspond to the On/Off status of home theater devices
are defined on P13-P16 (use SmartLinc�s ProbeLincs to
detect the On/Off status of these devices).

2. To turn on the lamp on C1 (assumes you have a lamp
plugged into a lamp module set to C1 or an X-10 compatible
switch set to C1) double-click on the lamp icon.  The icon will
change to look like an �ON� bulb and your light should turn
on.  By double-clicking again the light and icon should turn
back off (note: the flags are logicals and cannot be controlled
in this manner).

3. Setting up a new X-10 device is very simple.  For example,
to add a lamp at the address of C2 simply click on the Add
button in the Units window.  Then:

a) Click on the housecode for your device (C)
b) Click on the unit code for your device (2)
c) Select On/Off icons from the �Type� scroll list (e.g.
desklamp)
d) Enter a description for the device (e.g. Office)
e) For now, you can ignore or erase the information in
the location window
f) If your device supports preset dim commands, you
can select the PCS or Preset Dim option
g) Click OK - It�s that simple!

3. To change (edit) an X-10 device simply click in the Units win-
dow.
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4. To delete an X-10 device simply click on delete in the Units
window.

Setting up Infrared Devices

Note: You will need to setup your infrared devices even if you
previously programmed them using the temporary program-
ming cable provided in a SmartLinc Home Theater Kit.

1. Open the IR Devices window.  If it is not visible, it may be
minimized (in which case you can either resize it or select it
from the Windows pull down menu (item #3).  If it is not avail-
able from the Windows pull down menu, the software has not
identified the connected HouseLinc as being infrared �ready�.
Check to ensure that you are not running in demo mode.  If
you are, you may need to restart the software.  If you have
successfully connected to the HouseLinc, restart the soft-
ware.  If the IR Devices window  is still unavailable contact
technical support at 949-221-0480 x157.

2. Initially, you should have 4 sample IR devices previously
defined (see image above).  IMPORTANT: These devices are
used in events that have been predefined at the factory to
make your installation and enjoyment of home theater and
A/V control easier. DO NOT DELETE THE SAMPLE IR
DEVICES before becoming fully familiar with HouseLinc and
determining that you do not need them.  It is recommended
that you follow the instructions below (either for a device type
not included in one of the three samples or for a �test�
device), then click on the change button to modify the set-
tings for the sample items so that you may make use of pre-
defined events.

3. To configure HouseLinc to control your IR device (e.g. TV)
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a) Click on the TV icon
b) Click on Change
c) Click on the Type tab
d) Select the proper manufacturer for your TV from
the drop down list labeled �Select the manufacturer...�
e) Click on the Code tab (and the following window
will appear):

f) A small window with a 3 digit code will appear in the
upper left hand side of the screen.
g) Click on the Setup button - the 3 digit code (which
controls devices made by the manufacturer of your
device will be programmed into HouseLinc (and you
should receive) a �Device Setup Successful� mes-
sage.
h) Click on the Test tab
i) Make sure that you have a clear line of sight
between the front panel of HouseLinc and your IR
device (TV) (or that you have installed an IR emitter)
j) Click on the power (PWR) button to test the configu-
ration (or other button like channel + if you are trying
to operate a cable box or other device that does not
respond to power).
k) If you have selected the correct 3 digit code for
your device (TV) it should turn on.
l) If your device does not turn on (or if you receive an
error message, click on the Code button, select the
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next 3 digit code from the drop down list and return to
step g).
m) If you have tried all the 3 digit codes listed and
none have worked call technical support.  There is a
good chance that they will be able to instruct you to
try a different code already contained on your
HouseLinc�s IR chip or may be able to provide you
with a chip which has been upgraded for your device.
n) To configure the VCR, Receiver and CD Player for
your devices, start again from step a (and click on the
corresponding icon) for those devices.

To set up a new IR Device click on Add in the IR Devices window:

1. An IR Device Setup Wizard will walk you through setting up
an IR Device.

2. Click Next to begin.
3. From the top drop down list select a type of device (note

many �receivers� are listed in the Tuner section).
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4. From the bottom drop down list select a manufacturer.
5. Click Next
6. Select the output ports for the IR Device you are adding.

HouseLinc will �send� infrared control codes out any and all
ports that you select during this step.  The default is all ports.
You only need to change this if you will be installing a
�zoned� infrared control system.  By zoning you can have
multiple devices from the same manufacturer (even the same
model) and control them separately.  For example, if you
have two Sony TVs, you may wish to place the first Sony TV
on port 1 and the second Sony TV on port 2.  This will allow
you to turn the first on or adjust its volume without affecting
someone watching the second Sony TV.

7. Click Next

17
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8. Next, the Wizard will walk you through finding the proper
three digit �setup code� for your IR Device.  By dropping
down the list of codes you can determine how many codes
there are the for the manufacturer of your type of device (7
for the example of Sony TVs).  The easiest method of deter-
mining the proper code is to use the top �Setup� button.

a) Click on the drop down list of codes
b) Click on the code to test (1st code on the
list for your first attempt)
c) Click on the top Setup button
d) The setup code chosen in the drop down
list will be sent to HouseLinc
e) The message �saying device setup suc-
cessful� will appear.
f) Click OK
g) Click Next
h) A �virtual� test keypad will appear

http://www.smarthome.com
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i) Click on the PWR button (if your device
doesn�t have an PWR button, press a key that
is defined - e.g. channel up for a cable box.)
j) If your IR Device responds, you�ve probably
got the correct setup code, try a couple of
other buttons to confirm and skip to step 9.
k) Otherwise, you need to select try the next
setup code.  Return to step a in this sequence.

9. Click on Next

10. Chose icon, description and location for device
11. Click on Finish
12. Setup for this device is Complete!

To delete an IR Device click on delete in the IR Device window.
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Setting Up Timer Events

Example: Program HouseLinc to turn on the C1 lamp at sun-
set each evening.

1. Open the Timer Event Window (either by maximizing the
minimized Timer Event Window or by selecting it from the
Windows drop down menu).

2. Click on Insert to create a new timer event

The window that appears is the HouseLinc programming win-
dow.  A similar window will be used to setup and modify
almost all HouseLinc events.  The top portion of the window
is used for the event �trigger�, which in this case is time of
day.  The large window in the middle of the screen will con-
tain the steps of the event.  The remainder of the screen will
be used to program the event.

3. Click on the Time drop-down list.
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4. Click on Sunset (if you had wished to have the event occur
at a fixed time each day, you would have left time of day in
the time window and selected the hour, minute and am/pm
that you wished the event to occur).

5. Click on the Add button on the middle left side of the screen 

6. Choose X-10 from the list (This tells HouseLinc that you
want to add an X-10 command to your event.  If you had
desired, you could have added a scene (a predefined list of
commands which could contain X-10, Infrared or both), a
command group (a special type of scene) or IR output).

7. Click on the wide drop-down list at the middle of the screen.
All X-10 devices that have been set up in the Units window
will appear here.

Select C1 Lamp 1 (You may also click on the house code
and unit code for a device if you prefer)

8. The address (C1) will fill in automatically
If you had wished to add another command to this event you
would simply click on the Add button again and proceed from
step 5.

9. Click on the Radio button next to the white box below
�Description of Commands�
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10. Type a �title� for your event into the white box (e.g. Sunset
Lighting)

11. Click Done, You�re Finished!
12. Your Timer event window should look like this:

(For each event you define, the left hand side of the label
describes the trigger (in this case sunset) and the right side
contains the title you�ve given the event (in this case Sunset
Lighting).  You can use the buttons just above the list of
events to download your programming to HouseLinc (this is
required for any timer and X-10 Input events) or to copy,
paste or change your events.

Adding Qualifiers to Events

Example: Have the sunset lighting scene just described hap-
pen only on weekdays.

1. Click on the Change button in the Timer Events Window.
2. Click on the Add Qual button near the middle of the window

(to add a �qualifier� to your timer event - this qualifier will
make your event conditional on whatever qualifiers you add)  

3. Select Days/Months from the qualifier drop down list
The types of qualifiers include:

a) Days/Month: Will only run event on the selected
days of week or months of the year
b) X10 Unit states: Will only run event if the X10
device selected is in the selected �state� (e.g. only
turn on the bathroom fan if the bathroom light is
already on)
c) Time Range: Will only run event if time of day is
within selected range (e.g. only turn on the fountain if
it is between 9:00 am and 5:00 pm)
d) Freeze: Temporarily freezes the event line current-
ly highlighted.
e) Delay: Tells HouseLinc to wait the desire amount
of time (5 seconds to 1 hour) before performing the
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command line which is being qualified - note:
(HouseLinc will continue to monitor and execute other
events during this delay period)

4. Click on M-F (which stands for Monday thru Friday near the
left hand edge of the window)

Notes on Qualifiers:
a) You can add one of each type of qualifiers to each com-
mand line in an event.  A small tab at the bottom of the event
window will grant you quick access to all qualifiers that have
been added for the event.
b) If you wish the entire event to be qualified (assuming you
had more than one command line in the event) add the quali-
fier to the first line in the command window (that line is
always titled �Event Conditions�.
c) In order for any events to run automatically, they must be
downloaded.  (Simply click download from any event window
to download your latest event programming).

Setting Up X-10 �Input� Events

Example: Press Play on the VCR and turn C1 lamp on if
HouseLinc receives a B5 OFF.

1. Open the Plato Input Events window (either by resizing it
from a minimized version at the bottom of the screen or by
selecting it from the Windows drop-down menu).

2. Click on Insert to add a new event.
3. A window that looks very similar to the timer event will will

appear.  The primary difference is that instead of timer relat-
ed options at the top of the screen, X-10 �input� options will
appear.
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4. Click on the HCode drop-down list and select B.
5. Click on the Unit drop-down list and select 5.
6. Click on OFF
7. Click on the Radio Button under �Description of Commands�
8. Type in a �title� for the event �Movie Time�
9. Click on the Add button on the middle left of the screen.
10. Select IR Output (a �virtual remote� will appear)
11. Select the VCR from the drop-down list in the lower center

portion of the screen

12. Click on the Add button just to the left of the numeral 1 in the
IR keypad (this will add up to 7 IR outputs to the single com-
mand line you are creating)

13. Click on the button labeled �PLAY� 
Note that the selection of the VCR and Play will appear in
the �window� to the left hand portion of the screen.  Each
�line� of IR code in HouseLinc events can hold up to 7 total
IR commands.  Once you have chosen the IR device you
wish to control, you can continue to add new IR commands
for that device (even if it means adding another �line� to your
event).

14. Your event window should look like this:
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Note: There are 2 �lines� in the IR event window.  The first
puts HouseLinc into �VCR mode� (this puts the IR control
chip into VCR mode, just like pressing the VCR mode key on
a universal remote control).  The second sends a play (just
like pressing play on your VCR�s remote control).

15. Click on Add (middle left hand side of window) to add the X-
10 portion of this Event.

16. Click on X-10 Command
17. Click on C and 1 (or choose the C1 lamp from the drop down

list).
18. Click on the On button just to the right of the units window

(near the Dim button).
20. Click on Done, You�re Finished! 

Notes: Input events must be triggered by incoming X-10 sig-
nals.  (e.g. you cannot trigger the event by transmitting the
X-10 trigger out of HouseLinc).  To keep your input events
organized you may wish to keep them alphabetized.  To
�move� an input event, click on the event then click on the
Up and/or Down buttons to move it up or down as required.

Setting up Command Groups and
Scenes

Scenes and command groups are �re-usable� events.  They can be
embedded within multiple timer and X-10 input events.  For exam-
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ple, you may wish to create an event that makes sure all your home
theater equipment is off and then embed that logic into events like
goodnight, goodbye and vacation.  Command groups are identical to
scenes with the following two exceptions:

1) Command groups can be embedded in other command
groups and/or scenes (whereas a scene can only be embed-
ded within a timer event or X-10 input event).
2) You cannot assign an icon to a command group.

Example: Create an event that makes sure all home theater equip-
ment is off.

1. Open the Scenes and Command Group window (either by
resizing it from a minimized version at the bottom of the
screen or by selecting it from the Windows drop-down
menu).

One icon that �contains� all the Command Groups will be
present in this window (even if there are no Command
Groups defined).  One icon for each scene will also be dis-
played in this window (e.g. ABC, CBS, etc.)

2. Click on the Command Group Icon.
3. Click on the change button (this will allow you to change the

Command Group Settings).
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4. Click on New.
5. Type a �title� for the event into the Description window (in this

case type in (�All IR OFF�).
6. Click on the Add button (left center of window).
7. Select IR Output.
8. Select TV from the IR device window in the lower right hand

side of the window.
9. Click on the Add button near the center of the screen (next to

the 1 in the �virtual remote�)
10. Click on the PWR (power) button

Your IR event window should look like the image above (step
1 puts HouseLinc into TV mode, step 2 sends a power but-
ton).  But you only want the power button to be sent if the TV
is already on, so you�ll need to add a qualifier.

11. Click on Add Qual.
12. Select X-10 Unit States.
13. Click on the drop down box at the bottom center of the win-

dow
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A list of all previously defined X-10 devices will appear
(including flags corresponding to on/off status of ProbeLincs)

14. Click on P13 TV Probe
15. (Make sure that ON is selected under �State�) This means

that the event will only occur if P13 is ON (e.g. the TV is On).
You have now made sure that the TV is off, next repeat for
the VCR.

16. Click Add (middle left side of window)
17. Select IR Output
18. Select VCR from the IR devices drop down list (lower right

corner of window)
19. Click Add (middle of window)
20. Click PWR
21. Click Add Qual.
22. Click X-10 Unit States
23. Click on the drop down box at the bottom center of the win-

dow.
24. Click on P14 VCR Probe
25. (Make sure that ON is selected under �State�)
26. Repeat steps 16-25 for the Receiver and CD Player (note:

you may need to select the �OFF� state for your CD player
as many CD Players have status lights that are On when the
CD Player is OFF.

Your window should look like:
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27. Click Done to complete the programming of your �All IR Off�
command group.

28. Your �All IR Off� command group should be functionally iden-
tical to a command group titled �All Audio/Video Off� which
was programmed at the factory.

29. If you wish, you can delete your �All IR Off� command group
by highlighting it in the Command Groups window and click-
ing on Delete.

Notes:

Hardwired installations (using RS-232 touchscreens or other
controllers) trigger scenes only.  Given the fact that com-
mand groups are more flexible (can be embedded within
scenes) they are the preferred �reusable events�.  The pre-
ceding example could have also been achieved by creating a
scene with the only significant difference being that you
would have needed to choose an icon to accompany the
scene.

Hopefully, you now feel a little familiar with HouseLinc
events.  Simply edit �Change� the other input events, scenes
and command groups to get a feeling for at least one method
of creating �automated control� events for home theater
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applications.  Use copy and paste then change to make
adding new events easier.

Using the Monitor Window

1. Open the Monitor and Units windows and resize them so
they both can be seen on your screen.

2. Double click on the C1 Lamp 1 icon to turn it on.
3. Double click on the icon again to turn it off.
4. The commands that were sent (C1 ON and C1 OFF) will

appear in the Monitor window.  Monitoring activity can be
helpful in debugging your installation.  Click on the Options
drop-down menu to set the options (e.g. seeing more
detailed activity reports) for the Monitor window (the options
drop-down is only available if the Monitor window is active).

5. If you wish to �record� all the X-10 and IR traffic, select Open
Log from the File menu (this option is only available if you
have the Monitor window highlighted).  This will record all
information from the monitor window into an ascii file on your
hard-drive.

Adding a Blueprint or scanned room
image

1. Bitmaps (either created in a graphical edit program such as
Paintbrush or scanned in from a photograph) can be import-
ed into HouseLinc.  Note: If you are importing numerous

http://www.smarthome.com
http://www.smarthome.com


Smarthome.com, Inc.  (800) SMART-HOME  (949) 221-9200
http://smarthome.com

31

bitmaps, create the bitmaps using 256 color or less.  Then
icons for devices and scenes can be �dropped� onto these
house images for �virtual� control of the devices.

2. Click on the File drop-down and select Open Blueprint.
3. Enter the filename and path for your bitmap file.
4. Press OK
5. Enter a name for your blueprint (e.g. Living Room), this is the

name that will appear within HouseLine.  Also, select Main
Blueprint if this is the main view of the home.

6. Click on Add to add a device, event or link (a visual shortcut
to another blueprint)

7. Click on Link in the Item window
8. Click on the blueprint to link to.
9. Add a name (a label that will appear in the link button)
10. You�re Done.  Note: Executing any of the �All� commands

from within the blueprint view will affect all the X-10 devices
in the view regardless of their housecode.
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LIMITED WARRANTY

Seller warrants to the original consumer purchaser of this product that, for a period of two years from the
date of purchase, this product will be free from defects in material and workmanship and will perform in
substantial conformity to the description of the product in this Owner's Manual.  This warranty shall not
apply to defects or errors caused by misuse or neglect.

If the product is found to be defective in material or workmanship or if the product does not perform as war-
ranted above during the warranty period, Seller will either repair it, replace it or refund the purchase price,
at its option, upon receipt of the product at the address below, postage prepaid, with proof of the date of
purchase and an explanation of the defect or error.  The repair, replacement or refund that is provided for
above shall be the full extent of Seller's liability with respect to this product.

For repair or replacement during the warranty period, call SmartLinc customer service to receive an RA#
(return authorization number), properly package the product (with the RA# clearly printed on the outside of
the package) and send the product, along with all other required materials, to:

SmartLinc
attn: Customer Service Department
17201 Daimler Street
Irvine, California  92614

LIMITATIONS

THE ABOVE WARRANTY IS IN LIEU OF AND SELLER DISCLAIMS ALL OTHER WARRANTIES,
WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MER-
CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  ANY IMPLIED WARRANTY, INCLUDING
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WHICH MAY
NOT BE DISCLAIMED OR SUPPLANTED AS PROVIDED ABOVE SHALL BE LIMITED TO THE TWO
YEAR PERIOD OF THE EXPRESS WARRANTY ABOVE.  NO OTHER REPRESENTATION OR CLAIM OF
ANY NATURE BY ANY PERSON SHALL BE BINDING UPON SELLER OR MODIFY THE TERMS OF THE
ABOVE WARRANTY AND DISCLAIMER.

IN NO EVENT SHALL SELLER BE LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER
DAMAGES RESULTING FROM THE POSSESSION OR USE OF THIS PRODUCT, INCLUDING WITHOUT
LIMITATION DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, PERSONAL
INJURY, EVEN IF SELLER KNEW OR SHOULD HAVE KNOWN OF THE POSSIBILITY OF SUCH DAM-
AGES.

Some states do not allow limitations on how long an implied warranty lasts and/or the exclusion or limitation
of damages, in which case the above limitations and/or exclusions may not apply to you.  You may also
have other legal rights which vary from state to state.

Ó Copyright 1997-1999, SmartLinc
17201 Daimler Street
Irvine, CA 92614
(main) 949.221.0480 
(fax) 949.221.0488 
web:www.smartlinc.com 
email: inbox@smartlinc.com
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